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Introduction 
 
This document describes the procedure required to install and operate the Unipart Dorman 
DF11 Speed Feedback Sign.  
 
Unipart Dorman DF11 is a LED Speed Feedback Sign designed to provide a clear concise 
warning message to drivers that they are travelling above a predetermined safe speed 
threshold.  
 
There are three models available: 
 

 DF11M-B  - AC powered sign with Bluetooth data transfer  
 DF11MCB – AC Charged 4 cell battery powered sign, with Bluetooth data transfer 
 DF11SCB – Solar Charged 3 cell battery powered sign, with Bluetooth data transfer   

 
All models come supplied with a front mounted YOUR SPEED fascia in either yellow, yellow 
green or white backgrounds. A separate mounting back plate and U channel clips to allow 
band mounting to a variety of support posts are also supplied. 
 
Optional Feature: 
The signs can be data enabled this allows the sign to collect speed data which can be 
downloaded over the Bluetooth connection and manipulated using the supplied Stats Analyzer 
software package which allows the generation of effective reports.  
 
The LED display is equipped with an automatic brightness control and this manages the 
power usage to conserve battery life. When no traffic is present, the display remains blank to 
further limit power consumption. 
 
The DF11 has three configurable speed trigger points: 
 
Minimum Display Speed - the point at which drivers will first see their speed being 
displayed in a solid readout. 
 
Speed Limit - the point at which the drivers speed will change from solid readout to flashing 
readout - indicating a speed violation. 
 
Maximum Speed – This is the speed value which if exceeded will cause the display to go 
blank. 
 
DF11 signs operate from an internal LiFePO4 battery pack and charging is carried out by 
either connecting an AC Power charger using the multi-function plug at the bottom of the 
unit; or for more permanent locations an SP30S Solar Kit which feeds the battery pack from a 
separate cable which runs into a cable gland at the rear of the sign. The solar versions also 
have the facility to be charged using an external charger via the multi-function plug at the 
base of the unit  
 
There are hard wired options where the supply cable entry is via a gland at the rear of the 
sign and further details are available from Unipart Dorman. 
 
A ‘Your Speed’ front fascia with reflective diamond grade background color options of Yellow, 
Yellow Green or White is supplied as standard with the sign. 
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Interactive Online Tutorial 
 
There is an excellent tutorial supplied with the Houston Software and this can be found by 
clicking on the ‘Help’ tab of the Houston Radar launch screen as shown: 
 

 
 

FCC Compliance 
 

This equipment has been tested and found to comply with the limits for a class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation.  
 
This equipment generates, uses, and will radiate radio frequency energy and, if not installed 
and used in accordance with the instructions provided may cause harmful interference to 
radio communications.  
 
The radar in this device carries the FCC ID:  
 

     TIASS300. 
 

This information is also shown on a label affixed to the sign. 
 

Important Information 
 
Please review the following information before operating this device. 
 

WARNINGS 
 
READ ALL INSTRUCTIONS BEFORE USE AND SAVE THIS MANUAL FOR FUTURE 
REFERENCE 
 
DF11 units must be only be installed and operated in accordance with the 
instructions contained in this Handbook.  
 
Changes or modifications not expressly approved by Unipart Dorman could void 
any warranty or guarantee on the equipment.  
 
If the sign is installed by anyone other than the Unipart Dorman installation team, 
Unipart Dorman accepts no liability for any failures caused by the mounting or 
connection of the signs, including any calculations and/or specifications related to 
the mounting post or any associated foundations.   
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Safety Information 
 
The following safety information and warnings enable you to avoid potential harm to yourself 
and others; and possible damage to the equipment being operated and its surrounds. 
 
It should not be considered to be an exhaustive list of hazards you may encounter and should 
never be considered as a substitute for your judgment and experience or formalized risk 
assessment/hazard management protocols. 
 
Please read and observe all safety information and instructions in this manual 
before operating any equipment. You should keep this handbook in a safe place 
for future reference. 
 
If you are unsure about any part of these instructions or of the potential hazards listed, 
please contact Unipart Dorman immediately using the details at the back of this handbook. 
 
Please read all the following safety advisory messages before carrying out any 
work on this equipment. 
 
Whilst the unit is designed to be robust and resistant to damage, like all electronic 
equipment, care should be exercised when moving the sign to ensure that heavy 
blows/impacts are avoided.  
WARNING 

To reduce the risk associated with electric shock injury. 
 
Do not try to open the sign; there are no user serviceable parts inside the unit.  
 
Ensure that the electrical supply is isolated from the power input lead before 
disconnecting it from the sign during charging. 
  NG 

 

Radar RF energy can be harmful to the eyes.  
 
To reduce exposure to the risk of RF energy, do not stare into the sign window. 
Keep a minimum safe distance of 20cm (8-inches) from the display face. 
 
It should be noted that this equipment is battery operated and can at times 
transmit RF energy even when the sign display is blank and the sign appears to be 
disconnected from a power supply 
 

ARNING 

To reduce the risk of impact hazards resulting from falls, accidents with passing vehicles, and 
from unstable equipment: 
 
Use appropriate Traffic Management methods, equipment, and implement safe 
working procedures. 
 

WARNG 
Every care is taken to ensure that, as far as reasonably practical, the sign will perform 
without risk to health and safety. If you are in any doubt with respect to these instructions, 
please consult Unipart Dorman before proceeding.  
 
Please note that equipment and components described in this document may be protected by 
patent and no part of this document may be reproduced in any form without the written 
permission of Unipart Dorman.  
 
Unipart Dorman reserves the right to vary or modify any specification without prior notice. 
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INSTALLING THE SIGN 
 
Prior to any installation work commencing it is highly recommended that the installer 
undertakes a site survey evaluation and a full health and safety risk assessment covering 
installation, operation and maintenance.  
 
The DF11 comprises 2 main assemblies - the Sign and the Adaptor Plate which it fixes to. The 
Sign is designed to be quickly detachable from the Adaptor Plate; and this allows the 
purchase of a number of Adaptor Plates which can be permanently fixed and a single sign 
which is then rotated amongst the fixed plates to maximize impact on drivers.    

 
The optimum alignment of the sign face is pointing at the center point of the approach traffic 
lane(s) and at a distance of between 165 ft (50m) and 300ft (90m) from the sign. The sign 
should be mounted no less than 5 feet (1.5m) above the surface to ensure maximum radar 
performance. Unipart Dorman recommends a minimum height of 7 feet (2.17m) 
 
The Sign is mounted onto a quick release mounting plate using 3 robust steel mushroom 
head locating pegs which locate into keyhole slots. It is secured to the mounting plate using a 
standard padlock.  
 
The adaptor plate is supplied with Signfix Channeling and 2 off SX0220 u channel banding 
interface clamps which allow the installer to band mount the sign in position on a variety of 
support posts. Other mounting options for U channel such as bolting directly to Telespar are 
covered in the Signfix catalogue 
 
When fitted, the adaptor plate completely covers the on/off switch to prevent malicious 
operation. The rotary switch however is still accessible using the key.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Sign Mounting Hardware (showing a representative padlock) 
 

Charging the sign 
 
Both Solar and AC Power charged signs need a full charge cycle prior to the first deployment. 
A full cycle will take approximately 8 – 12 hours.  
  
The external charger simply plugs into the multi-function socket at the bottom of the sign. 
Whilst the sign is charging, the red LED on the charger is illuminated. When the battery pack 
is charged to capacity this LED will go green. 
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Please note:  
 
The DF11 battery pack contains Lithium Iron Phosphate (LiFePO4) which is a rechargeable 
battery and like all rechargeable batteries, they need to be exercised by placing the sign 
through a full charge – discharge – full charge cycle every few months. 
  
If the sign is to be placed in long term storage which in this case means anything in excess of 
6 weeks the battery should be fully charged before storage and then the battery should be 
exercised every 3 months.  If this schedule is not adhered to, it is possible that the battery 
could self-discharge to a point where it could not be "revived" even after being charged.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This space intentionally blank 
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Charger Variants 
 
The AC Power and Solar versions of the sign each have their own version of the same 
Tenergy Battery Charging Pack. The solar powered version has a 2 Amp 9.6 Volt charger (3 
Cell battery Pack) and the 110V AC Power charged version has a 1.5 Amp 12.8 Volt charger 
(4 Cell battery Pack). Care must be taken to ensure the correct charger is used to charge the 
sign as the chargers are visually identical except for the label.  The pin arrangement in the 
multi-function plug is specifically designed to prevent cross connection and if the sign does 
not appear to charge the first thing to check is that the correct charger is used. 
 

 
 
 

Remember: 
 
 Solar = 3 Cell Charger 
 
 AC Power = 4 Cell Charger 
  

Operating the sign 
 

Turn on the power to the DF11 by using the grommet switch located on the back of the unit 
(One push/click for on and a further push/click for off). When the sign is turned on, it will 
enter a brief self-test mode where the digits display will count up from 1 to 9 then display 88 
with a flashing white strobe light and then go blank. The self-test is complete and the sign is 
now ready for use. A small yellow LED will illuminate in the middle of the sign to indicate it is 
on.  
 
 

 
 
It should be noted that the switch is covered by the adaptor plate when the sign is fitted to 
it. This security feature prevents malicious operation. 
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Introduction to Speed Setting 
 
Typically, users set the trigger speed at 10% + 2 Units above the speed limit on the road 
and the high-speed display cut off at a speed sufficiently above the speed limit to capture 
most of the speeding traffic but not high enough to encourage “racing against the radar”. A 
low cut off value is also set which only enables the display if the target exceeds this setting, 
and is used primarily to filter out low speed traffic such as bicycles etc. thus preserving 
battery life. 
 
 
Configuration of the sign can be made by either a hard wired data cable PC or a Bluetooth ™ 
wireless PC connection. 
 
If the rotary speed selector switch is enabled (see later section on manually setting speed 
parameters), turn the speed switch to the desired position (0 - 7) to select preset speed 
values in the sign.  
 

Installing the Stats Analyzer 
 
The Stats Analyzer software should auto load from the Disc provided and you will be 
presented with the following screen during the loading process: 
 
 

 
 
Please accept any requests the software makes for ‘changes to your computer’ and then click 
on Close when the Installation is complete. 
 
The Stats Analyzer will place an icon on your desktop and double clicking this will launch the 
analyzer: 
 
 
 
 

This space intentionally blank 
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Registering the Software (where required) 
 
When initially installed, the Houston Software will be on an initial 30 day expiry ‘basic’ 
package. It is important that users install the free upgrade to the ‘Pro’ version by opening the 
Stats Analyzer and clicking on the help menu and selecting ‘Activate Pro Version’. 
 

  
 
 
 
 
 
 

This space intentionally blank 
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This will bring up a dialogue box as shown below and you should click on Request Activation 
Key which will launch your email editor with a prefilled message and then simply press send. 
 

 
 

 
 

The activation key may take up to 3 working days to arrive from Houston; when it does 
simply copy and paste the supplied key into the activation box found as shown above. 
PLEASE NOTE: 
 
Some firewall systems may reject incoming mail from Houston Radar. You should contact 
your system administrator to ensure that your system will accept the activation code email. If 
there are any difficulties surrounding this activation code, please contact Unipart Dorman as 
soon as possible. You should send your activation request at the earliest possible opportunity 
to ensure the 30 day period will not expire prior to the successful receipt of an activation key 
 

Configuring the sign using Bluetooth ™ wireless PC 
connection 

 
There are many different combinations of Bluetooth ™ hardware available and you must 
ensure that you have followed the manufacturer’s instruction carefully regarding the setting 
up of Bluetooth ™ on your device. If the device requires you to enter a pairing code, please 
enter 0000 
 
Ensure that you have the latest version of Stats Analyzer fitted to your device and the 
Bluetooth ™ is operational. Launch the analyzer and select ‘Connect to Radar’ 
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Then you will need to select which COM Port on your device which your Bluetooth ™ is 
configured to use. If you know already please select it from the dropdown as shown, or if not 
select Auto Detect Port.  
 

 
 

If you select Auto Detect the system will try each port individually to detect the Bluetooth ™ 
Device and this could take some time to achieve. As soon the system has connected with the 
radar a dialogue box will confirm the system setting information and then a Radar Found Pop 
Up will appear.  You can clear these boxes by clicking OK. (You may wish to note the COM 
Port used to speed up future connection processes): 
 
 
 
 

This space intentionally blank 
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The Radar Found box will display a data transfer speed, it should be noted that these speeds 
are variable depending on a number of different things. However, if you feel the data transfer 
speed is excessively slow, please contact Unipart Dorman for advice.  
 
Successful connection to the sign is shown by the legend shown at the bottom of the screen. 
 

 
 
 
Please note that the pop up boxes may appear behind the screen you are currently viewing if 
you have more than one application running. This can mean that anything you try to click 
onto when in the Houston screen will be inactive until you have cleared the pop up boxes by 
clicking on the OK button. 
 
 
 

This space intentionally blank 
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Connecting to the sign using hard wired PC connection 
 
 

 
 
 

The DF11 features a standard cable interface that can be used to configure the display and 
download captured speed data onto a Laptop/PC running the Stats Analyzer software. The 
cable plugs directly into the multi-function socket located on the base of the unit. The cable 
only needs to be finger tight and any excess force applied will result in damage to the 
connectors, which may not be covered by any warranty. 
 
Connect the cable as shown above using a suitable USB to Serial Port Connector (not 
supplied) and then run Stats Analyzer by double clicking the icon previously installed on your 
desktop then use the same instructions to connect to the radar as shown in the previous 
section, ignoring the Bluetooth ™ com port set up. 
 

 
 
 
 
 
 
 
 
 

This space intentionally blank 
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CONFIGURING THE SIGN 
 

Setting the Sign’s Internal Clock 
 

Before synchronizing the clocks, please ensure the computer you are using is 
displaying the correct time value. Your computer user manual should give you 

instructions on the correct way to set the time. 
 
It is recommended that the radar clock is synchronized to the computer time setting at each 
sign connection as this will keep the sign software calibrated. This is carried out by simply 
clicking on the ‘Sync Radar Clock to Computer’ button. Synchronization is complete when the 
Radar Clock Value (shown ringed) is the same as the computer time as shown in the bottom 
left of your screen.  
 

 
 
 
 
 
 
 
 
 
 
 
 

This space intentionally blank 
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Setting the Trigger Points 
 
Select the Radar Set Up tab and the PNL10 Setup tab. Alterations to the trigger point settings 
can be made by either the dragging the cursor along the speedline or altering the values in 
the boxes. 
 
The trigger speed setting is set using the red Speed Limit Box/Red Cursor and the upper and 
lower speed limits are set using the green Minimum/Maximum Display Speed boxes/Green 
Cursors. Once the settings are made please click on the ‘Write to Radar’ box to transfer the 
new settings to the sign 

 

 
 
 

The Minimum setting should be set sufficiently high to prevent the sign being triggered by for 
example a jogger approaching the sign, but low enough to capture approaching motor 
vehicles. Careful consideration of this value will allow the sign to create the maximum impact 
but preserve battery life as much as possible. 
 

White Strobe Configuration 
 
The DF11 has a white LED cluster (strobe light) arranged in a circle in between the two 
digits typically used to draw attention to drivers that their current vehicle speed is above the 
set speed limit. The flash rate of the strobe is set at 10Hz and may be selected to activate 
above the trigger speed limit as well as above the high-speed limit.   
 
The strobe is enabled/disabled using the radio buttons shown below which appear on the 
Radar Setup Tab 
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Manual Adjustment of Trigger Speed setting 
 

Manual adjustment is useful on signs which are moved frequently between locations and 
where each individual place has a different set of criteria for speed setting. The 8 different 
presets available mean that the speed parameters can quickly be set without connecting a 
computer to the sign via Bluetooth ™ or cable. Initially Position 0 is set as a datum and each 
click of the switch will increment the speed settings by the value shown in the ‘Rotary Speed 
Switch Increment’ box. 
  
The sign is set to the following values in the factory: 
 

Switch Position Min Display Speed Speed Limit Max Speed Cut Off 
0 3 5 30 
1 8 10 35 
2 13 15 40 
3 18 20 45 
4 23 25 50 
5 28 30 55 
6 33 35 60 
7 38 40 65 

 
 
 
To adjust the values first click on the ‘Enable Rotary Switch’ button and ensure that there is a 
tick in the box 
 

 
 
Clicking on ‘Adjust Limits’ will enable the speed parameter boxes to be altered and set for 
position zero on the rotary switch. Then define the increment that the speed settings will 
change by for every click of the switch by setting the value in the Rotary Speed Increment 
box. So for instance if you wanted the speeds to increase 5 MPH for every click of the rotary 
switch, you would enter five in the Rotary Speed Increment box. Use the Test Rotary Switch 
Position box to cycle through the seven remaining switch selections to see the values set for 
each switch position.  
 
 
 
 

This space intentionally blank 
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The ‘Check Limits’ selection allows the user to cycle through the parameters already set into 
the sign.  
 

 
 
 
Clicking the ‘Display Speed Limits Table’ button will bring up a handy table showing the 
parameters each rotary switch position is set to. This can be printed and kept with the sign if 
required. 
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To change the speed settings manually, remove the bung covering the access port and insert 
the Dorman Adjustment tool to adjust the spindle, where each click is the next switch 
position. When the switch has been turned fully anticlockwise it will be at the zero setting. Do 
not use excessive force during adjustment. 
 
Please note that if the Enable Rotary Switch box is not ticked, manual adjustment is not 
possible. 
 
Once the adjustment is complete, remove the tool and re-insert the bung. Failure to re-insert 
the bung correctly will compromise the IP rating of the sign, and any moisture ingress or 
subsequent damage may invalidate any warranties applied. 
 
 

 
 

Adjustment Tool fitted 
 
 

 
Manual Speed Adjustment Tool (Dorman Part Number C62.62025) 

 
 

 
 

Bung fitted correctly after adjustment 
 
 

 
 
 
 
 
 

This space intentionally blank 

 
 
 
 
 
 
 
 



P a g e  | 19 
 

C64.64167 Issue 1 Jul 2012 
 

Detection and Units Tab 
 

This tab allows users to select between MPH and KPH and also the mode that the radar 
performance is set in. The sign will be factory set at 100% sensitivity and the traffic will be 
detected as the fastest inbound targets. It is not anticipated that there will be any need to 
alter these settings. Please consult Unipart Dorman before any alterations are made. 
 

 
 

Data Output/Hardware & IO Config Tabs  
  

 
 
The settings in these tabs are factory set. If any of the values are altered without first 
consulting Unipart Dorman, the performance of the sign may be severely degraded and could 
result in the sign being returned to works for resetting, which would be outside any warranty 
agreements.  

 

DATALOG FACILITY 
 
The DF11 has an optional datalog facility which allows the capture of sign activation statistics 
and the generation of spreadsheets and graphs to allow users to monitor the sign’s 
effectiveness, especially where it is deployed in a variety of locations. It is possible to 
generate average data by hour for each day of the week and also view weekly and monthly 
averages.  
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Open a Project 
 
Prior to downloading the data from the sign you need to set up a new project which will 
contain all the data and provide the tools necessary to manipulate it into reports and graphs. 
Click on File>New/Open Stats Project and then as shown click on new project and then enter 
a name for the project in the pop up box, which could be example the sign location and 
download date. 
 

 
 

Click on OK and then on the next screen select the project required and then select Open. If 
you are not already connected to the sign via Bluetooth ™ or cable you will be prompted to 
do so. 
 
If you wish to work with a previous project, simply select the project from the list and click on 
Open.  
 
 
 
 
 
 
 
 
 
 
 
 
 

This space intentionally blank 
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Working with the Data 
 
The following screenshots provide a self-explanatory guide to the processes required to 
generate and print reports in various formats: 
 
 

 
 

The Monthly Counts/Speed Avgs tab shows in a weekly view the average counts or speeds 
for a specific hour segment averaged over an entire month. The values highlighted in Orange 
show the highest speed for the timeframe selected. Available months are shown and selected 
in the drop down circled in red on the picture above. 
 
The Weekly Counts tab shows the same information but averaged across one week and 
again, the week is selected using the dropdown circled in red. 
 

Generating Charts and Graphs  
 

 
 

Selecting one of the three Chart tabs highlighted above will give speed and volume graphs 
depending on which tab is selected. 
 

 
 

Selecting File>Print will allow you to make a hardcopy of the graph or it can be copy it onto 
the Windows Clipboard and then paste into any Microsoft Office Program. 
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SERVICING THE SIGN 
 
It is recommended that routine maintenance is carried out at six monthly intervals as detailed 
below. This period may need adjusting depending on the conditions of use and should be 
revised after each maintenance visit. 

Battery Husbandry 
 
The DF11 battery pack contains Lithium Iron Phosphate (LiFePO4) which is a rechargeable 
cell and in common with other rechargeable batteries, they need to be exercised by placing 
the sign through a full charge – discharge – full charge cycle. Unipart Dorman recommends 
that this process is carried out every few months if normal operational usage means that the 
battery pack is only ever partially discharged/charged. 
  
If the sign is to be placed into long term storage (which in this case means anything in excess 
of 6 weeks),  the battery should be fully charged before storage and then exercised every 3 
months.  If this schedule is not adhered to, it is possible after an extended period in storage 
that the battery pack could self-discharge to a point where it could not be "revived" even 
after being charged.   

Time Stamp Reset 
 

Signs which have the optional Stats Analyzer function generate time-stamped historical 
records that are saved in an on-board FLASH memory. This means that the DF11 needs to 
maintain accurate calendar date and time information once it is has been set. 
 
Should the sign may suffer a disruption in its power supply, the time/date information will be 
lost but can be reset by following the instructions in the CONFIGURING THE SIGN section.   

Visual Check 
 
Visually check the enclosure and screen for damage, paying particular attention to any 
external cabling, specifically checking for security of attachment.  

Enclosure Cleaning 
 
Clean the enclosure and front screen with a cloth and mild detergent solution. Abrasive 
materials or solvent based cleaners should never be used.  

Radar Performance 
 
If there are problems where the sign is triggering late or fails to trigger when the 
approaching vehicle is clearly exceeding the set speed, consideration should be given to 
clearing all significant radar energy reflectors from within the radar footprint. Please contact 
Unipart Dorman for further advice.  

End of Life Recycling 
 
All components in the DF11 are designed with End of Life Recycling in mind. Neither the sign 
nor any of its component parts should not be disposed of as standard waste, this is 
particularly important with regard to the battery pack as it contains small amounts of Lithium.  
 
Please contact Unipart Dorman for the very latest instructions and methods of disposal.   
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Contact Us 
 

Unipart Dorman 
 

173 Main Street 
Bath, 
ON  
K0H1G0 
Canada 

 

Phone:         613-352-3458 
 

Fax:             613-352-6845 
 

E-mail:         enquiry@unipartdorman.com 
 

Website:      www.unipartdorman.com 
 

 
 

Every effort has been made to ensure the accuracy of the information given in our 
Publications, but in accordance with our policy of continually improving our products we 

reserve the right to modify designs and specifications whenever necessary. 
 

The content of this document is the property of Unipart Dorman and information contained 
therein is confidential. This document either in whole or part, must not be reproduced, or 

disclosed to others, or used for any purpose other than that for which it is supplied without 
Unipart Dorman’s written permission; or if any part is furnished by virtue of a contract with a 

third party, as expressly authorized under that contract. 
 

The contents of this document are copyright © Unipart Rail 2012 - All rights 
reserved 
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